The information in this document is subject to change without notice and applies only to the version of hardware, software or firmware called out on the title page.

CDI shall not be liable for any damages, including but not limited to, interruption of business, loss of profit, incidental, consequential or any other claims either by the operator(s), the operator’s employer, or any other party. CDI shall not be liable for any damages incurred by the operator(s) or any other person as a result of the operator(s) use or misuse of this product, even if CDI had been advised of the possibility of such damage.

The CD42-R Receiver Firmware is copyright © 1993-2007.

This document is copyright © 1999-2007 CDI. All rights reserved.

Document Number 89-09-0001-00
Rev. G (September 20th, 2007)

For information on obtaining the latest version of the CD42-R receiver’s firmware, contact CDI.

CDI
1801 North Juniper Avenue
Broken Arrow, Oklahoma 74012 USA
http://www.pigging.com
support@pigging.com
+1 (800) 580-4234   Toll Free (North America)
+1 (918) 258-6068   Worldwide
+1 (918) 251-9851   FAX

---

**NOTICE**

Any operation involving work on pipelines containing gases or liquids under pressure is potentially hazardous. It is necessary, therefore to follow correct procedures in the use of this equipment to maintain a safe working environment.

No person should use this equipment unless fully aware of potential hazards of working with pressurized pipelines and trained in the procedures stated in this manual.

The purchaser of this equipment is responsible for the training and competence of the operators and the manner in which it is used.
Table of Contents

NOTICE ............................................................................................................................................. 2

TABLE OF CONTENTS .................................................................................................................... 3

CHAPTER 1 - INTRODUCTION ........................................................................................................... 5
  Who Is CDI? ..................................................................................................................................... 5
  The Purpose of the CD42 .................................................................................................................. 5

CHAPTER 2 - RENTER’S QUICKSTART .............................................................................................. 6
  Unpacking and Assembling the CD42 System .................................................................................. 6
    The Receiver ................................................................................................................................. 7
    The Antenna .................................................................................................................................. 8
  The Transmitter ............................................................................................................................... 9
  Transmitter Specifications ............................................................................................................... 9
    The CD42-T0 (Figure 5) ............................................................................................................... 9
    The CD42-T1A (Figure 6) ........................................................................................................... 9
    The CD42-T1 (Figure 7) ........................................................................................................... 10
    The CD42-T2 (Figure 8) ........................................................................................................... 10
  What to Look for While Tracking and Locating ............................................................................ 12
    Pig Passages ............................................................................................................................... 12
    Stationary or “Stuck” Pigs ......................................................................................................... 13
  Conclusion ...................................................................................................................................... 14

CHAPTER 3 - THE RECEIVER .......................................................................................................... 15
  Overview ........................................................................................................................................ 15
  Screen Blanking .............................................................................................................................. 15
  Main Operation Screen .................................................................................................................... 15
  Gain Buttons .................................................................................................................................. 16
  Help Button .................................................................................................................................... 16
  Recording Pig Passages .................................................................................................................. 17
    Entering the Location ID ............................................................................................................ 19
    Automatic Record Mode .......................................................................................................... 20
    Manual Record Mode .............................................................................................................. 22
  File Menu ...................................................................................................................................... 23
    Selecting a Recording File ......................................................................................................... 23
    Erase a Recording File ............................................................................................................... 23
    View a Recording File ............................................................................................................... 24
    Tag a Recording File ............................................................................................................... 25
    Calculate a Pig’s Speed ............................................................................................................ 26
    Print a Recording File .............................................................................................................. 27
  Setup Menu ................................................................................................................................... 29
    LCD Backlight ......................................................................................................................... 30
    Meter Display ............................................................................................................................. 31
    “More” Button of the Setup Screen ......................................................................................... 31
    LCD Contrast ............................................................................................................................... 32
    Setting the Clock ........................................................................................................................ 32
    Battery Voltage Measurement ................................................................................................. 34
    Recording Options ..................................................................................................................... 35
    Beeping On/Off ........................................................................................................................... 36
    Restore Defaults (Fix) .............................................................................................................. 37
  Connecting the Receiver to a Desktop PC .................................................................................... 38
    View/Transfer File Data ............................................................................................................ 40
Dump File Dates/Times........................................................................................................43
View Transmitter Signal......................................................................................................44
Version/Statistic Info.........................................................................................................45

**CHAPTER 4 - TRANSMITTERS** ......................................................................................46

**SPECIFICATIONS** ........................................................................................................46
CD42-T0 (Figure 69) ........................................................................................................46
The CD42-T1A (Figure 70) ..............................................................................................46
CD42-T1 (Figure 71) ..........................................................................................................46
CD42-T2 (Figure 72) ..........................................................................................................47

TRANSMITTER PATTERNS ..............................................................................................49
MOUNTING THE TRANSMITTER ON YOUR PIG .........................................................50
Foam Polypigs ..................................................................................................................50
Metal Bodied Pigs ..............................................................................................................50
Miscellaneous Pigs ...........................................................................................................50

TRANSMISSION STRENGTH AND BATTERY LIFE ....................................................50
ROUTINE MAINTENANCE OF TRANSMITTERS ..............................................................50

**CHAPTER 5 - THE ANTENNA** ......................................................................................52
GENERAL PURPOSE ANTENNA ....................................................................................52

**CHAPTER 6 - TRACKING A MOVING PIG** .................................................................53

USING THE CD42 TO "LEAPFROG" ..............................................................................53
LEAVING THE CD42 UNATTENDED ..............................................................................54

**CHAPTER 7 - LOCATING A STATIONARY OR STUCK PIG** .....................................55
FINDING THE PIG’S GENERAL VICINITY ......................................................................55
PINPOINTING A PIG’S PRECISE LOCATION .................................................................56

**APPENDIX A - SPECIFICATION SUMMARY** ..........................................................58
THE RECEIVER ................................................................................................................58
THE TRANSMITTERS .........................................................................................................58
THE ANTENNA ..................................................................................................................59

GLOSSARY OF TERMINOLOGY ......................................................................................60

INDEX ................................................................................................................................61
Chapter 1 - Introduction

The CD42 is an extremely useful, rugged and reliable piece of field equipment that allows simple yet powerful tracking and locating of pipeline pigs.

The customer feedback that we receive regarding the CD42 system is exceptionally positive. We have many customers in all corners of the world that use this system and appreciate its usefulness, simplicity and ruggedness. If, for whatever reason, a customer is dissatisfied with our products, we work without reservation to insure that the situation is resolved.

This manual explains the step-by-step use of the CD42, but just as importantly this manual explains many of the more generic techniques used for pig tracking and location. Familiarizing yourself with these techniques will allow you to use CDI’s equipment to its fullest.

Who Is CDI?

CDI is an electronics product development company located in Broken Arrow, Oklahoma near Tulsa. Founded in 1982, CDI has spent many years in the oil and gas industry creating a variety of industrial electronic products. Our diverse design and implementation experience in many fields give us a unique capability to meet the needs of the pipeline pigging industry with more rugged, powerful and easy to use electronic devices.

The Purpose of the CD42

The CD42’s primary purpose is to allow an operator to both track and locate pipeline pigs. A pipeline pig is a device that is usually made of solid polyurethane or a polyethylene foam and is often shaped roughly like a bullet. These devices are placed into oil and gas pipelines for three primary purposes:

- To separate two fuel products from one another.
- To clean the inside of the pipeline.
- To detect corrosion on the inside and outside of pipe walls.

Pigs, once placed into the pipeline, are normally propelled through the pipeline by the movement and pressure of the product behind them. A pig’s journey through the pipeline can be as short as a few hundred feet and a few minutes, or as long as several hundred miles and several weeks.

Initially it doesn’t seem like much can go wrong with this simple process. You put the pig in one end, it’s pushed through the pipeline by flow and it drops out the other end. As with most jobs, however, pipeline pigging is hard work fraught with difficulties. In pigging, a “difficulty” is usually defined by a pig becoming stuck in the pipeline. Sticking a pig can occur when the pipeline has an unexpected bend, valve or dent, or has perhaps sagged and buckled from vibration or soil erosion. When the pig becomes stuck in the pipeline, the flow is constricted considerably, sometimes completely. To correct the problem, the pipeline usually needs to be excavated and the dented section of pipe replaced. This is where the CD42 comes in. By attaching a transmitter to the pig before it is launched, operators on the surface can easily and quickly find the trouble spot and begin excavation.
Chapter 2 - Renter’s QuickStart

This section of the manual is designed to be read by people who are using the CD42 for the first time and would like a quick overview of how the system is put together and how it operates. The CD42 has several advanced functions such as pig passage recording and pig speed calculation that cannot adequately be covered in a brief overview. If you require more information on these advanced topics, please refer to the section of this manual entitled “Chapter 3 - The Receiver” beginning on page 15.

Unpacking and Assembling the CD42 System

Opening the CD42’s carrying/shipment case reveals the various components of the system:

- CD42-R Receiver Unit
- CD42-Tx Transmitter
- CD42-GP General Purpose Antenna
- Transmitter Mounting Flange Kit
- Connecting Cables
- Batteries and Miscellaneous Components and Tools

To assemble the system, begin by removing the red receiver unit from the carrying case. Notice that the receiver’s main features are a large Liquid Crystal Display (LCD), two rows of three buttons each, and a silver three conductor connector. The LCD is used to display the transmitter signal strength to the operator, the buttons are used by the operator to control the CD42’s various functions, and the connector is used to attach the reception antennas to the receiver unit.

Begin by installing 5 D-Cell batteries into the receiver unit if there are none currently installed. To install the batteries, you must remove the rear watertight cover of the receiver unit by loosening the four screws at the four corners using a Phillips head screwdriver. Once the rear cover has been removed, the five D-Cell battery holders should be visible as shown below in Figure 1. Install 5 new D-Cell batteries and replace the rear cover of the receiver. Reinstall the rear cover and tighten the screws using a proper Phillips head screwdriver. Without the rear cover in place, the receiver unit is not watertight.

![Figure 1](The 5 D-Cell Batteries of the CD42-R Receiver Unit)
Remove the supplied connecting cable from the case and attach the proper end to the CD42-R receiver unit. *The connectors on each end of the cable are “keyed” to the receiver and antenna connectors to insure that they will mate only in their proper orientation.*

Next, remove the CD42-GP antenna from the carrying case. The GP antenna provides very good sensitivity with a high rejection of the earth’s magnetic field (why this is important is covered in detail in “Chapter 5 - The Antenna”).

Complete the basic assembly by connecting the loose end of the connecting cable to the GP antenna’s female connector. Again, notice that the connector is “keyed” for proper orientation.

**The Receiver**

Now that the system’s basic assembly has been completed, turn the receiver unit on by pressing the “top” two buttons simultaneously. The “top” two buttons of the receiver are the ones nearest the cable connector, and are indicated by two thick black lines between the LCD display and the buttons themselves. *Instructions for turning the unit on and off are also printed on the rear panel of the receiver.*

Notice that each of the six buttons is associated with a small picture or “icon” on the LCD that indicates the function of the adjacent button.

At this point, pressing any single button on the receiver will bypass the welcome screen and display the main working screen of the receiver. The main screen is shown in Figure 2.

![Figure 2: The Main Screen of the Receiver](image)

The main screen shown above is where all actual pig tracking and locating is performed when using the CD42 receiver, and for the most basic tracking and locating jobs is the only screen needed. Simply put, it is not necessary to have any further knowledge of the menu items to perform useful tracking and locating operations.

Notice the text near the center of the LCD that reads “Gain: x” (x represents a number from 1 to 9). This indicates the current sensitivity level of the receiver to transmitter signals. There are two buttons in the upper right-hand corner of the receiver that allow quick adjustment of the sensitivity of the receiver. The icons of these two buttons are up and down arrows and are labeled “GAIN”.
Pressing the “up arrow” gain button increases the receiver’s sensitivity, while pressing the “down arrow” gain button decreases the sensitivity. A good starting gain level for the unit is “5”.

Once the receiver’s gain is set, gently bump the attached GP antenna. Doing so should produce a small but noticeable ripple to appear, flowing slowly from the right to the left on the receiver’s display. If no noticeable ripple appears after bumping the GP antenna a few times, then the cable connection should be checked. Bumping the antenna should produce a result that looks similar to Figure 3:

![Figure 3 An Input Signal Flows Across the Screen](image)

Successfully having performed these steps indicates that the receiver, cabling and antenna are operating correctly and are ready to receive transmitter signals.

**Note:** The CD42 system is based upon magnetics. The transmitter emits a pulsing magnetic field that is received by the antennas and displayed to the operator on the receiver’s LCD. As with just about any transmitter/receiver system there are potential sources of interference, most of which the system is able to filter out on its own. However, jarring the receiving antennas will produce spikes of interference on the LCD. It is recommended that you experiment with the system at different gain (sensitivity) settings until you feel comfortable with what to expect.

**The Antenna**

The CD42-GP receiving antenna is quite sensitive, with a through-pipeline range of approximately 15 feet using our smallest transmitter. The GP also has a proprietary design that allows it to reject the magnetic noise produced by moving it through the earth’s magnetic field. The benefit of this technology to the end-user is that he can walk and search for transmitter signals simultaneously; a great time saver when performing field work.

The antenna should normally be held in a parallel orientation to the transmitter in the pipeline. Since the transmitter is normally mounted onto a pig in an orientation parallel to the pipeline, the antenna should be held parallel to the pipeline as well. This means that when walking above a pipeline that runs North/South, the length of the antenna should also be running North/South, offering the best possible reception of transmitter signals.

A GP antenna oriented parallel to a pipeline should look something like Figure 4:
The Transmitter
The transmitter is the single most important component of the CD42 system, and CDI has worked hard to deliver the most durable, longest life transmitters in the industry. All of our transmitters emit a magnetic field that passes through the pipeline and is received on the surface by our CD42-GP antenna and passed on to the CD42-R receiver unit. CDI’s two most common transmitters are the CD42-T1 and the CD42-T2 (both of which are available for rental or purchase). The main difference between the CD42-T1 and the CD42-T2 transmitters is simply signal strength; the “T2” is 6.5 times more powerful than the “T1”. This allows the CD42-T2 transmitter to work in larger and deeper pipelines than the CD42-T1.

Transmitter Specifications

The CD42-T0 (Figure 5)
- Typical transmission range through pipe of approximately 15 feet
- Recommended for use in pipelines 4” to 6 diameter” in
- Guaranteed minimum 500 hour battery life (21 days)
- Pressure rated to 1,250 PSI [86.2 bar]
- Cylindrical dimensions of 7.00” X 1.66” [178mm X 42mm]
- Powered by 6 N-Cell alkaline batteries

The CD42-T1A (Figure 6)
- Typical transmission range through pipe of approximately 25 feet
- Recommended for use in pipelines 8” to 28” in diameter
- Guaranteed minimum 500 hour battery life (21 days)
- Pressure rated to 1,500 PSI [103.4 bar]
- Cylindrical dimensions of 9.9” X 1.9” [251mm X 48mm]
- Powered by 6 AA-Cell alkaline batteries
The **CD42-T1** (Figure 7)

- Typical transmission range through pipe of approximately 25 feet
- Recommended for use in pipelines 8” to 28” in diameter
- Guaranteed minimum 500 hour battery life (21 days)
- Pressure rated to 2,500 PSI [170 bar]
- Cylindrical dimensions of 10.7” X 3” [272mm X 76mm]
- Powered by 6 AA-Cell alkaline batteries

The **CD42-T2** (Figure 8)

- Typical transmission range through pipe of approximately 50 feet
- Recommended for use in pipelines 30” to 60” in diameter
- Guaranteed minimum 375 hour battery life (15½ days)
- Pressure rated to 2,500 PSI [170 bar]
- Cylindrical dimension of 13” X 4.4” [330mm X 112mm]
- Powered by 6 C-Cell alkaline batteries

The number of variables in pig location and tracking with magnetics make it virtually impossible to predict the exact signal strength that you will see from a transmitter in a given pipeline. Below is a short list of things that cause a drop in signal strength to the receiver:

- Pipe wall thickness
- Metallic pipeline coverings such as road casings
- Large pipeline diameters
- Depth of pipeline cover
- Battery strength

The greatest transmitter signal losses are usually caused either by distance from the transmitter or metal between the transmitter and the receiving antenna. Soil and water between the transmitter and receiver does not cause any signal loss except for the loss caused by the increased distance between the transmitter and receiver.
Replacing the Transmitter's Batteries

Remove the CD42-Tx transmitter from the carrying case and examine it. Notice that its only real distinguishing features are that it has one removable end, and a narrow groove that runs around its middle. The removable end is for the insertion of batteries, and the groove around the middle is to allow the transmitter to be attached to a metal bodied pig with the use of an optional flange kit.

Using a Phillips head screw driver, loosen the five screws to remove the cap (Figure 9).

WARNING:
Use caution when removing the end cap of any transmitter. An O-Ring seal is used to withstand the pipeline pressures and if this seal becomes damaged or excessively dirty, pipeline pressure can leak into the transmitter and destroy it. Further, pipeline pressure can become trapped inside the transmitter. Always point transmitters away from yourself and others when removing the end cap. Should you require replacement O-rings, they are readily available from CDI at a nominal charge.

Once the end cap is removed, the battery carousel (Figure 10) slides out easily. The CD42-T0 transmitter requires N-Cell alkaline batteries. The CD42-T1A and CD42-T1 transmitters both require AA-Cell alkaline batteries, while the CD42-T2 requires C-Cell batteries. CDI recommends installing a fresh set of standard alkaline batteries prior to every pig run.

At this point you should change the “continuous on” mode to “standard pulse” mode. (See sheet 49 of this manual for instructions).
To reassemble the transmitter, simply reverse the disassembly procedure. After installing new batteries into the carousel, slide it into the transmitter’s body. Be sure that you replace the battery carousel in the proper orientation. The carousel is clearly marked as to which end should be left facing out when you drop it into the transmitter. *Ensure that once the batteries have been installed, you can see the text “THIS END OUT” on the side of the battery holder that is facing outward.*

Once the battery carousel has been placed correctly into the transmitter, place the cap of the unit back into place. If you find it difficult to reinstall the cap, check the O-Ring for lubrication. If the O-Ring is dry, bare rubber, apply some Vaseline or other petroleum based jelly to it and to the inside of the transmitter body where the O-Ring meets. This should remedy the problem. Screw the cap back in place with the five screws.

CDI’s transmitters have no On/Off switches that might become dirty over time and fail, so the transmitters operate whenever their batteries are installed. Therefore, the transmitter should now be transmitting its magnetic signal.

**What to Look for while Tracking and Locating**

If you have followed the procedure above to this point, you should have a fully assembled and tested CD42-R receiver and CD42-GP antenna. Place the transmitter about 5 paces away from, and parallel to, the receiving antenna. If the transmitter has been correctly assembled you should now see standard transmitter pulses flowing from the right to the left on the receiver’s display that looks similar to Figure 12. Note that the gain is set to 3 for this test.

The pulses that are flowing across the display shown above are what you should look for when using the equipment in the field. Below is a more specific discussion of how these pulses look in a true work situation. If you do not see any pulses from the transmitter on the display of the receiver, check your assembly of each device and the cabling. If you continue to have problems, please don’t hesitate to call CDI at the numbers on the title page of this manual.

**Pig Passages**

Normally a pig’s progress through a pipeline is monitored by an operator with a CD42 receiver “leapfrogging”. This is the process of setting up in a location, waiting until after the pig passage has
occurred at that location, and then quickly moving to the next location and repeating the process. The CD42 easily shows the operator the pig’s passage at each location.

When an operator sets up the CD42 receiver at a location to await a pig passage, he should orient the receiving antenna parallel to the pipeline. As the pig approaches the location and then moves away, it produces a distinctive wave shape on the display. Figure 13 is an example of a typical pig passage at a speed of approximately 4MPH. Faster pig passages produce the same image, it simply will have fewer pulses in it.

The CD42 receiver has the ability to record up to 99 of these pig passages, including the entire image, time, date and mile or kilometer marker of the event. To learn more about some of the CD42-R receiver’s advanced features, please read the section entitled “Gain Buttons” beginning on page 16. For a more thorough discussion of tracking, interpreting and recording the passages of pigs, please refer to “Chapter 6 - Tracking a Moving Pig” beginning on page 53.

Stationary or “Stuck” Pigs

Although being able to witness pig passages as shown above is a very valuable feature that allows you to monitor the progress of a pig through a pipeline, the CD42’s ability to locate a stationary or “stuck” pig is perhaps its most important feature. If you’ve rented the CD42-K1 system, then you are probably concerned that you are about to run a pig through a pipeline in which it might get stuck at some point.

The best way to ensure the minimum amount of work in the event that a pig sticks in the pipeline is for the operator to track the pig’s progress through the pipeline by leapfrogging. If the pig does stick, then the operator will know when the pig does not pass by his location. He must then backtrack by walking the pipeline to his last known-good passage location while looking for transmitter pulses using the CD42-R receiver. For this reason, it is best for the operator to locate his leapfrogging points on the pipeline as close to one another as possible. This will minimize any distance that the operator will have to walk.

Note: It is important for the operators of the equipment to determine the flow rate of their pipeline, how fast the pig will be moving, and if they will be able to get from one leapfrogging point to the next with a few minutes of setup time to spare.
As the operator approaches the location of the stuck pig, the signal will begin to rise on the display of the receiver. As he walks over the transmitter’s location within the pipeline, the signals will peak, and walking further past the transmitter will cause the signal to fall again. This process is much like watching the passage of a pig as described before under “Pig Passages”, except the operator passes by the pig instead of the pig passing by the operator.

Once this rough location of the pig within the pipeline has been determined by walking the line, it is possible to precisely locate the stuck pig to within just a few inches by using a “nulling” technique. For a discussion of nulling, please refer to the more detailed section on locating pigs entitled “Pinpointing a Pig’s Precise Location” beginning on page 56.

**Conclusion**

We believe that, although brief, this section gives you a quick jump-start on how to use the CD42 Pig Location and Tracking System to successfully track and locate pigs. The process is actually fairly simple and straightforward, and requires only a modest amount of time to learn.

The remainder of this manual is dedicated to explaining in greater detail the more advanced aspects of the CD42 system, and should be read by anyone who plans to use the system for long periods of time, or who needs or wants to use some of the system’s more advanced features such as recording and printing pig passage data.
Chapter 3 - The Receiver

Overview

The CD42-R receiver is responsible for simply and accurately displaying the pulses of transmitters to the operator. CDI has invested many hours of design and refinement into the receiver, and the process continues daily. Since the CD42-R is essentially a computer system, software upgrades are possible, and do occur occasionally to add a new feature or repair small bugs in the system. Some of our best feature additions have come from listening to the feedback of our customers, so if you have a feature request or a bug report, please don’t hesitate to contact CDI at the numbers listed on the title page of this manual.

Screen Blanking

The CD42-R receiver, like many computers, has the ability to shut down its display during periods of inactivity. The CD42-R screen blanks after a period of five minutes, which conserves energy and allows the unit to run even longer on its standard set of 5 D-Cell batteries. When the screen blanker has been activated the unit will look as though it is off, but rest assured that it is not. To bring the unit out of screen blank mode, simply press any single button on the faceplate. When the screen is blanked, pressing a button will have no effect other than to turn the display on, so it is unimportant which button you press. In other words, if you press the SETUP button to bring the unit out of screen blank mode, you will not go into the SETUP menu. You would have to press SETUP twice to do so: once to end the screen blanking mode, and once to actually enter the SETUP menu.

If the unit has been set up to record pig passages, it will still do so even though the screen has gone blank. When the pig is detected and a recording begins, the unit will automatically bring itself out of the screen blank mode, including turning on the back light.

Main Operation Screen

The CD42’s major feature is its large graphics liquid crystal display (LCD). This display is used to show the pulses of magnetic transmitters to the operator of the equipment. The height of the pulses indicates how close the transmitter is to the receiving antenna. Figure 14 is a CD42-R receiver with a cable and antenna attached, ready to receive transmitter signals.
The graphical display of the CD42-R allows us to show the pulses of the transmitter to the operator in the most intuitive way possible, and is the key to the CD42’s ease of use.

Each of the six buttons on the face of the receiver unit has a function associated with it. The function of each button may change as you navigate through the receiver’s menu system; as the functions change, the icons are updated to reflect the new functions. Therefore, by referring to the small icon on the display adjacent to the button, the user always knows the function of each of the buttons.

**Gain Buttons**

The Gain control icons are located in the upper right of the CD42’s display. These two buttons control the sensitivity of the receiver to the transmitter’s magnetic field. The “up” button with the plus sign on it causes the receiver to become more sensitive, and the “down” button with the minus sign on it causes the system to become less sensitive. As you press these two buttons you will hear a chirp from the system indicating that the button was pressed, and you should also notice the text “Gain x” near the center of the display change as you make adjustments. The Gain is adjustable from 1 to 9, with 1 being the least sensitive and 9 being the most sensitive.

![Gain Icons](image)

The reason the sensitivity adjustment is necessary is that there are situations in which the system can receive magnetic interference from the environment. One such source of interference is an automobile in close range to the system. By allowing the operator to control the system’s sensitivity, he can adjust the sensitivity to fit his surroundings and his work habits. Normally a good starting Gain value is 5. At a Gain of 5 the system can be operated while walking with no difficulty or possibility of missing a transmitter’s signal. At very high Gain settings, it may be necessary to be careful of bumping and jarring the antenna as you walk. This is normal and is a side effect of using magnetics for pig location and tracking.

**Help Button**

Pressing the help button allows the operator to receive brief help on the functions of the Main Menu buttons. These buttons are “File”, “Setup”, “Record”, “Gain Up/Down” and “Help”.

![Help Icon](image)

To use Help, simply press the Help button. A text screen will appear asking you which Main Menu button you would like help with. Pressing the button that you would like help with will display information on that button. Figure 17 is an example display of Help for the Setup button.
Recording Pig Passages

The ability to record up to 99 individual pig passages is one of the CD42 receiver’s most useful functions. The receiver has the ability to, in real time, analyze incoming magnetic signals against the known pattern of our transmitters. If such a signal is detected by the system, the receiver will record that signal for as long as it is within range. This allows an operator to leave the system completely unmanned at locations where one or more pig passages are expected to occur and trust that the system will record the events for him.

These are the six major pieces of information recorded by the unit when pig passages are detected:

1. **Complete image of the recording.**
   A complete image or “picture” of the recording is saved, allowing the operator to review the data. These pig passage images can be viewed on-screen or printed to paper and placed into a pigging log file. See the section entitled “Print a Recording File” beginning on page 27 for more information on printing recorded pig passage data.

2. **Time and date of the recording.**
   The exact time and date of when the recording began is recorded.

3. **The mile or kilometer marker.**
   The mile or kilometer marker of the recording’s location is saved if the operator has chosen to set it. Setting this value also allows the CD42-R receiver to calculate the pig’s speed.

4. **Gain Setting.**
   The gain or sensitivity setting at the time of the recording.

5. **Duration.**
   The length of the recording in time.

It is really quite simple to start the receiver looking for transmitter signals. Simply press the REC or “Record” button in the lower left hand corner of the main screen (the REC icon is shown above). When you press this button, the unit will ask you to enter your location ID if the “Location ID” feature is active. The location ID feature of the unit is discussed on page 36 in the section entitled “Location ID”. For thorough information on how to set your location ID, please refer to that section. If you are prompted to enter your location ID, the screen will look similar to Figure 19.
If location ID is active, enter your mile or kilometer position on the pipeline and press the button labeled “OK”. If location ID is not active, the unit will immediately begin watching for a pig passage. When recording has been initiated, the display will return to the main screen with two small differences. The REC icon will have changed to one that reads “STOP REC”, and text will be displayed that indicates that the unit is waiting for a pig passage and has seen zero thus far. Figure 20 is a picture of how the main screen should look when the receiver is waiting for a pig passage:

At this point the receiver is waiting patiently for a pig passage to occur. When a pig passage is detected, you will hear a series of rapid beeps indicating that a recording has begun. If the unit has been in screen blank mode, it will turn the screen and back light on as necessary so that an operator, if present, can view the passage as it occurs. Once the pig and transmitter have traveled out of range, the unit will issue a slower series of beeps to indicate that the recording process is over. Once the unit has been set up to record pig passages in this way, it will continue to do so until its memory is full, or 99 pig passages have been recorded.

**Note:** Do not turn the CD42 receiver off during the recording process - always wait until the pig has passed and the unit issues the slower series of beeps to turn off the power. If the unit is turned
off during a recording, all recording data will be lost. Turning off the CD42 receiver during a recording is much like turning your desktop computer off while it is writing data to the hard disk drive.

When the pig passage has been recorded, simply press the “STOP REC” button to instruct the receiver to stop watching for pig passages. After pressing the “STOP REC” button, the receiver may be moved without concern of causing a false trigger to be recorded.

**Entering the Location ID**

Before pig recording is started, whether in manual or automatic mode, the operator has the opportunity to enter a unique “Location ID” for each site. The Location ID can be the mile or kilometer marker of the current location, or it can simply be a number from 0 to 999. If the operator uses the mile or kilometer Location ID, he may use that information to calculate the pig’s traveling speed as discussed below in the section entitled “Calculate a Pig’s Speed” beginning on page 26.

When an operator presses the RECord button to begin recording pig passages, the Location ID menu is shown and should appear similar to the one shown in Figure 21. At this point the operator may enter a Location ID. The operator has the option of entering the Location ID in any of the available fields. For instance, if the operator enters a number in the MILE field, the CD42 receiver will automatically update all other fields as well.

![Figure 21 Setting the Location ID](image)

Entering a Location ID is quickly done using the red navigation buttons. The Left and Right arrow buttons control the movement of the cursor throughout the screen. The Up and Down arrows, labeled (+) and (−), change the value of the selected field. Simply press the Left or Right button until the field to be changed is highlighted, and then press the Up or Down arrow to select the correct value.

When the correct Location ID is entered, press the OK button to save this information and enter record mode. To cancel the record operation and return to the Main Menu, press the Abort button at any time.
The operator may have chosen to enter Location ID’s as a numeric value. If this is the case a small window displaying the Location ID will appear. Refer to Figure 22. Using the arrow keys in the same manner as described above, enter a numeric value up to three digits long.

Note: The Location ID does not relate to Mile or Kilometer distances in any way. The numbers are completely arbitrary and should be used in cases where the operator’s pipeline does not conform well to using Mile or Kilometer markers.

![Figure 22 Numeric Location ID](image)

**Automatic Record Mode**

When the CD42 is in automatic mode and the operator presses the RE Cord button on the main screen (Figure 23), the CD42 receiver unit will continuously monitor the incoming signals and attempt to automatically detect, count, number and record pictures of transmitter passages without an operator’s presence. This feature is not available in any other system on the market.
As the CD42-R records pictures of pigs passing, they are stored as individual PICture files. For example: if three pigs are launched equipped with CD42-T1 transmitter units, as the pigs pass the unattended location of the CD42-R, attached to a CD42-GP antenna, three PICture files will be created in the unit’s memory. Each PICture file will be stored with the time and date of passage. The operator may then retrieve the CD42-R and antenna at his convenience and review the files as described later in the section titled “View a Recording File” on page 24.

When the CD42-R detects a pig passage, it will emit a series of beeps to indicate to the operator that a pig recording session is underway. The display will change to read “Auto Recording” (Figure 24) and the number of pig passes will also update to reflect the current pass. When the CD42-R ends the recording, it will emit another slightly slower series of beeps. If the CD42-R is in sleep mode when the pig passage occurs, it will turn on the display and back light so that the operator can be aware of the pig passage.

**Main features of Automatic recording mode:**
- Auto-starts PICture recording when pig passages are detected.
- Once started, will not continue to record indefinitely, but will stop after the pig has passed.
- Pig passages are recorded as individual PICture files, complete with time, date and count.

![Figure 23 The REC Button On the Main Screen](image)

![Figure 24 Automatic Recording](image)
When the operator presses the RECord button to begin recording, the caption on the RECord button changes to STOP RECord. Press this button again to end the recording of pig passages. To setup the CD42-R for Automatic recording, refer to the section titled “Recording Options” on page 35.

Note: While in record mode, the other options on the Main Menu do not function. To enter setup, adjust GAIN, etc. you must press the STOP RECord button first.

Manual Record Mode

When the CD42-R is operated in Manual record mode, the receiver will record PICture data for as long as the operator desires. For instance: if the CD42-R were in Manual record mode and the operator pressed the RECord button in the lower left-hand button of the Main Screen (refer to Figure 23) the unit would begin recording a PICture file. The CD42-R would continue to record the same PICture file until the operator pressed the RECord button again to halt it, or the CD42-R had exhausted its internal memory.

The Manual mode function is most useful when the operator wishes to record something of interest that may not be a transmitter passage (such as interference from motors, etc.). It may also be necessary, when in an extremely noisy magnetic environment, to use the Manual mode (Figure 25) to capture a pig passage manually rather than using Automatic mode.

Main features of Manual recording mode:

- Once started, Manual mode continues to record indefinitely until the operator presses the RECord button again, or memory is full.
- Useful for recording in magnetically noisy environments.

When the operator presses the RECord button to begin recording, the caption on the RECord button changes to become STOP RECord. Press this button again to end the recording of pig passages. To setup the CD42-R for Manual recording, refer to the section titled “Recording Options” on page 35.

Note: While in record mode, the other options on the Main Menu do not function. To enter setup, adjust GAIN, etc. you must press the STOP RECord button first.
File Menu

Selecting a Recording File

Before a recorded PICture file can be accessed, it must first be selected. To select a file, first press the FILES button on the main menu. Refer to Figure 25. If there are any files saved in memory, then a list of those files will appear (shown in Figure 26). If there are many files (the CD42-R has the ability to store up to 99 PICs, or pig passages), then they will fill the screen. If there are no recorded files saved in memory, then the FILES button will not activate.

![Figure 26 Available File List](image)

The files are organized by the Date and Time of the recording. To navigate through the file list, press the up or down arrows to advance the highlighted field to the file you wish to select. The number located inside the up arrow icon is actually part of the TIME field for each file. The TIME field displays the hours and minutes, and the up arrow icon displays the seconds. This is useful if two or more recordings are very close in time.

The two lines at the top of the display, above the Date and Time header, are status indicators for the file that is currently selected. As you move the highlighted bar through each file, the status indicators update to reflect the information for that individual file. The indicators display the current file number, the total number of files, and the Location ID for the selected file. This makes it very easy to locate a stored file based on mile marker information or other easily identifiable locators.

Erase a Recording File

In order to erase a recording file, a file must first be selected according to the procedures stated above in the section titled “Selecting a Recording File”. After the file to be erased is selected, press the Erase button (Figure 27) on the left side of the screen. When the ERASE button is pressed a warning box displays, giving you the opportunity to cancel the ERASE function. Figure 28 displays this warning box.
To cancel the erase operation and return to the file list, press the ABORT button. If the OK button is pressed, the file is immediately erased! There are no more chances to cancel the ERASE operation.

View a Recording File

In order to view a recording file, a file must first be selected according to the procedures stated on page 23 in the section titled “Selecting a Recording File”. Viewing a PIC waveform allows the operator to review any data that has been recorded in the computer’s memory. This is very useful for unattended operation of the CD42-R. For instance, the operator may place the CD42-R close to a pipeline, knowing that several pigs equipped with CD42-T1 transmitters should be traveling by within the next 24 hours. If the CD42-R is configured to record in automatic mode, each one of the pig passages will be recorded as its own PIC file without an operator being present. When the operator returns to the equipment 24 hours later, he merely selects the File Submenu to review the dates and times of all the PICs. This data gives him the dates and times of all pig passages. If he is unsure that any one of the dates and times is an actual pig passage, he may choose to view the PIC to be certain that the data is indeed a pig passage. To do so, he places the highlight bar on the file he wishes to view and presses the View button (Figure 29).
Pressing the view button will present the operator with a screen displaying the waveform of the PIC file (Figure 30). Once the operator is viewing the file, he may review the entire PIC file by scrolling to the left and right using the left and right buttons.

There is a small position indicator that preempts the lower solid strip area of the display when in the View menu. It displays the approximate position of the recording within the recorded data.

When finished viewing the PIC file, simply press the Back button to return to the File Submenu. Pressing Back once more returns to the Main Menu. The PIC data will be available for viewing until the operator deliberately erases it. PIC data is not lost when the CD42-R unit is turned off.

**Tag a Recording File**

Tagging a Recording file is a step that must be completed before a pig’s speed can be calculated. Two files must be tagged in order to calculate the pig’s speed between the two locations, as entered in the Location ID for each PIC file. To access the File Tag function, press the More button on the File Submenu.
The list of available PIC files is displayed on the screen, each noting the time, date and Location ID of each pig pass. Using the up and down buttons, highlight the first file to be tagged. Pressing the File Tag button (Figure 31) places a plus (+) sign next to the tagged file (Figure 32). Repeat this procedure for the second file to be tagged. If you would like to untag a file simply highlight the selected file, press the File Tag button once more, and the file is no longer tagged.

![Figure 31 File Tag Icon](image)

These files will stay tagged until the file is erased, or the operator chooses to untag the file.

**Calculate a Pig’s Speed**

In order to calculate a pig’s speed as it moves through the pipeline, accurate Location ID’s *must* be used when recording a pig passage. Knowing the distance traveled is a critical component in calculating the pig’s speed.

To access the Calc Pig Speed function, press the More button on the File Submenu. First, make sure two file recordings have been tagged, as described in the previous section. After the desired files have been tagged, press the Calc Pig Speed button (Figure 33).

![Figure 33 Calculate Pig Speed Icon](image)
The CD42-R will now use the data that was saved with the PIC file to calculate the pig speed. A screen similar to the one in Figure 34 will display the pig speed information.

![Figure 34 Pig Speed Information](image)

The pig speed information is divided into three sections labeled Distance, Elapsed Time, and Speed.

The *Distance* section displays the total distance the pig traveled between the two Location ID’s entered with the file recording. This distance is displayed in Miles, Feet, Kilometers, and Meters.

The *Elapsed Time* section displays the time it took the pig to travel between the two points. This information is displayed two ways. The first line is TOTAL, which includes hours, minutes, and seconds. The second line is SECS, which is the total number of seconds.

The *Speed* section displays the average speed of the pig. This is displayed in Miles Per Hour, Feet Per Second, Kilometers Per Hour, and Meters Per Second.

The pig speed is calculated as an average speed between the two selected files. If the first and last recordings are tagged then the average pig speed is calculated for the entire run.

To exit the Calc Pig Speed screen, press the Back button to return to the File Submenu.

**Print a Recording File**

*The CD42-R PICture files may be printed to any Epson® compatible dot matrix printer.*

To print a PICture file, it is necessary to remove the gray Access Plate on the rear of the CD42-R receiver unit. The Access Plate is removed by removing the four screws securing the Access Plate to the CD42-R. Once the Access Plate is removed, the operator can connect a standard printer cable to the printer port connector on the CD42-R. The printer port is easily identifiable; it is the large 25 pin connector.
Once the printer is connected, powered on, and online the operator can proceed with printing any previously recorded PICtures. Using the same steps described earlier in ‘Viewing a Recorded File’, the operator selects a file to be printed by placing the highlight bar on the appropriate file.

**Single Recording File Image**

Once the desired file is selected, press the Print button (Figure 35):

![Print Icon](image.png)

*Figure 35  Print Icon*

At this time an option screen is displayed which gives the operator two options: print a single File Image from the file list, or print a list of all file recordings. To print a File Image, press the File Image button.

If the printer is online and connected, it will immediately begin printing the PICture file image. If the printer is not online, the operator will instead receive an error message. Press any button to clear the error message and return to the File Submenu screen (see Figure 36). Correct the printer error and try again.
When the File Image completes printing it should resemble the PICture file stored in the CD42. The PICture file information also prints out with the File Image. This information includes the file date/time, the Location ID, what type of antenna was used, the gain setting, and the duration of the recording. There is also an area for the operator to record any notes that may apply to the File Image printout.

When the File Image has completed printing, the CD42-R returns to the file list display, where another File may be selected for printing if so desired. Press the Back button to return to the File Submenu, and once more to return to the Main menu.

**Complete Recording File List**

In addition to printing a single file image, an option is available to print a list of all currently recorded pig passages. This option prints the recorded details for each file. It prints the time/date, the Location ID, the type of antenna, the gain setting of the CD42-R, and the duration of the recording.

The List All report is accessed by pressing the Print button on the File Submenu. When the “Print Which?” option screen is displayed, press the List All button. If the printer is online and connected, it will immediately begin printing the PICture recording file list. If the printer is not online, the operator will instead receive an error message (Figure 36). Press any button to clear the error message and return to the File Submenu screen. Correct the printer error and try again.

When the List All report has completed printing, the CD42-R returns to the file list display, where a PICture File may be selected for printing if so desired. Press the Back button to return to the File Submenu, and once more to return to the Main menu.

**Setup Menu**

There are several options that the operator may choose when setting the CD42-R unit up for field usage. These various options are described in the following sections in detail.
The Setup button on the main screen (icon shown in Figure 37), will give the operator the opportunity to change or verify the settings of the various aspects of the CD42-R system.

![Setup Icon](image)

*Figure 37  Setup Icon*

When the Setup button is pressed, the operator is presented with the Setup screen (shown in Figure 38).

![Setup Menu](image)

*Figure 38  Setup Menu*

The Back button (icon shown in Figure 39) allows the operator to “back up” one menu level at a time to return to the main screen and resume standard pigging operations.

![Back Icon](image)

*Figure 39  Back Icon*

**LCD Backlight**

The backlight of the CD42-R’s display is the greatest single electrical drain on the 5 D-Cell batteries. Therefore, turning the backlight off when not needed can significantly increase the life of the CD42-R system. The Light button (icon shown in Figure 40) allows the operator to manually turn the backlight of the display on or off. If the backlight is currently ON, pressing the button will turn it OFF. If it is OFF, pressing the button will turn it ON.
Often, in outdoor daylight the backlight is unnecessary, and in fact it is usually impossible to even tell if it is on. Because it can be difficult or impossible to tell if the backlight is on, there is a Dashboard icon that indicates the backlight’s current status at all times. The backlight is ON when an icon that looks like that in Figure 41 is displayed. When the Light button is pressed, the Dashboard icon will change immediately to reflect the new status.

![Light Icon](image)

**Figure 40**  Light Icon

Meter Display

An analog-style signal strength meter is available for display on the main screen. This is in addition to the normal waveform display, and will reside in the upper left-hand corner of the screen. The Meter button (icon shown below in Figure 42) allows the operator to enable or disable the Meter display option. The status of the Meter option will be displayed in the message area when the Meter button is pressed.

![Meter Icon](image)

**Figure 42**  Meter Icon

“More” Button of the Setup Screen

On the Setup screen there is one button labeled “More”. This button icon is shown below in Figure 43.

![More Icon](image)

**Figure 43**  More Icon

This icon indicates that there are more options available. When the operator presses this button on the Setup screen, he is presented with more Setup options, shown in Figure 44.
As with the previous screen, pressing the Back button takes the operator back to the previous menu level.

**LCD Contrast**

The CD42-R has a digitally controlled contrast adjustment. When the operator is in the Setup screen, the “Dark” buttons (Figure 45) will allow him to adjust the contrast of the display to suit the current viewing conditions.

When the display contrast is set to a suitable level, press the Back button to return to the Main screen. The contrast adjustment is stored in the nonvolatile memory of the microprocessor, and is restored to the system every time it is powered up. It will not be necessary to set the contrast every time the unit is turned on.

**Setting the Clock**

The CD42-R has an on-board real-time clock that allows the system to record the date and time of a pig passage and name the PICture file. For the date and time to have any real meaning, they must be correct at all times; this option, therefore, allows for setting the clock. The system clock continues to run even when the CD42-R unit is turned off, so the operator does not have to set the clock every time the CD42-R is turned on. It will be necessary however, to occasionally set the clock.
Pressing the Set Clock button gives the operator the screen shown in Figure 46 below.

![Figure 46 Clock Adjustment](image)

Using this screen, the operator sets the clock. The Back button accomplishes its normal task of moving back one screen. The arrow keys control the movement of the cursor through the various time and date fields (see Figure 47).

![Figure 47 Left and Right Icons](image)

The left and right arrows control the movement of the cursor (always initially located on top of the hours digits) from one set of digits to the other. The operator should use these arrow buttons to position the cursor on top of the value to be changed.

Once the cursor is positioned on the correct field, the up and down arrow buttons (Figure 48) change the value of the field.

![Figure 48 Up and Down Icons](image)
The up and down arrow buttons function in a logical manner to change the value of the selected field. If the operator presses the up arrow on the minutes field, the minutes are incremented by one. The down arrow would decrement the minutes field by one. The time, day and date are all set in this manner.

When the time and date are set correctly, press the Back button. This will back the System up one screen, and the time and date will be stored.

The System displays what it believes to be the current time and date at the bottom of the screen as shown in Figure 49.

![Old Time Display](image)

*Figure 49* Previous Time

This information is displayed to the operator simply as a reference to the current time the CD42-R has stored. This old time cannot be restored once any changes are made in the time or date fields. If the operator presses the Back button without making any changes to the time or date, the old time will remain the current time.

**Battery Voltage Measurement**

One of the nice features built into the CD42-R receiver is the ability to, at any time, check the voltage of the 5 D-Cell batteries. This is accomplished by simply pressing the Batt Volts button as shown below in Figure 50.

![Battery Volts Icon](image)

*Figure 50* Battery Volts Icon

When the Batt Volts button is pressed, text will appear informing the operator as to the current battery voltage of the system in DC Volts as shown in Figure 51.
This section describes the record options in the setup section. For detailed instructions on the different types of record modes and how to record pig passages, refer to the section titled “Recording Pig Passages” earlier in this manual.

**Recording Modes**

In order to change the record mode the CD42-R is currently using, the REC button is pressed (Figure 52).

![Record Icon](Figure 52)

When the operator presses this button, he is presented with a screen as shown in Figure 53.
The current Record Mode is shown next to the REC button. To change the Record Mode, press the RECORd button to toggle between Manual and Automatic record mode. When the correct Record Mode is displayed, press the Back button to exit the record options screen.

**Location I.D.**

To enable, disable, or change the format of the Location ID’s, press the RECord button to enter the record options screen. Refer to the figures above for descriptions of the REC button and the Record Options screen.

Once the REC button has been pressed and the Record Options screen is showing, the current format for the Location ID will be displayed. The options for the Location ID are: Miles, Kilometers, Numeric, and Not In Use. Pressing the LOC ID button will step through each of these options. Once the correct selection is displayed, press the Back button to exit the Record Options screen.

The main purpose for this option is to select the format for the Location ID used when recording a pig passage. This format determines how the pig recordings are identified or numbered.

Set the Location ID to Not In Use if you do not intend to track pig recordings by Location ID at all.

Set the Location ID to Miles or Kilometers if you plan on tracking pig recordings by location on the pipeline. This setting is necessary if pig speed is going to be calculated.

Set the Location ID to numeric if you simply want to track pig recordings by a standard 3-digit number. This number will automatically increment for each pig recording or the number can be manually set.

**Beeping On/Off**

When an operator is locating or tracking a pig with a competitor’s tracking system, they indicate transmitter pulses by deflection of a needle meter accompanied by a beeping tone. The CD42-R emulates this beeping tone. With our microprocessor system, however, this beeping can be set to either on or off. We have found that with a largely visual system such as the CD42-R, this beeping
tone is bothersome to some. Therefore, if the operator wishes to do away with this beeping, he simply goes to the More screen of setup and presses the button marked Beep (Figure 54).

![Beep Icon](image)

**Figure 54  Beep Icon**

When the Beep button is pressed, the Beep option will toggle on and off. The current Beep setting will be displayed in text at the bottom of the screen in the message area.

The display will read “xmitter pulses will beep” or “xmitter pulses will not beep”. When the Beep option is set to the desired setting, simply press the Back button to return to the Main screen. The new setting is recorded as the default, so that the next time that the CD42-R unit is turned on, the beeping option will remain the same.

**Restore Defaults (Fix)**

If the operator is having problems with the operation of the CD42-R unit, a possible solution is to perform a software reset. This option can be found on the More screen of setup, and is labeled Fix (Figure 55). This option restores all default settings for setup options, deletes all recorded pig passages, and resets the system. This should only be performed if the CD42-R unit is malfunctioning.

![Fix Icon](image)

**Figure 55  Fix Icon**

To perform the system reset, press the Fix button. At this point the operator receives a warning message (Figure 56), and is given the option to Abort the procedure if necessary.
To cancel the system reset at this point simply press the Abort button. The CD42-R returns to the settings menu, and displays “Fix Aborted” in the text area. To proceed with the Fix, press the OK button. The CD42-R returns to the settings menu, and a text message is displayed in the text area: “Default Values Restored” (Figure 57).

![Figure 57 Message Displayed After Fix](image)

After the Fix is complete, any option that was changed from the default setting will need to be configured again.

**Connecting the Receiver to a Desktop PC**

The CD42-R receiver has the ability to communicate to a desktop PC through the use of a standard RS-232C communications link. This kind of connection is commonly referred to as a "serial connection" or "direct connection". In order to use a connection of this type, a standard RS-232C serial cable must be provided by the operator. A "null modem" type of cable, often used for serial communications is not necessary to communicate with the CD42R. A standard RS-232C serial communications cable should be used. The receiver unit itself requires the cable to have a male DB9 connection end, while the user's computer will vary. Please check the back of your computer for the appropriate connection type.

Once the proper hardware connection has been made, it is necessary to run a terminal emulation program such as ProComm or Windows' HyperTerminal. HyperTerminal is readily accessible to a great many users because it comes as a standard installable option of Windows 95 and Windows 98. For users that intend to use the serial connection often, it is strongly suggested that a better program be installed and used, for while HyperTerminal will get the job done, it is not particularly feature rich or easy to use. There are several free or inexpensive shareware Windows based terminal emulation programs available via the Internet at [http://www.download.com](http://www.download.com) search for "TERMINAL". A personal favorite is "Zoc" by EmTec located at [http://www.emtec.com/zoc/](http://www.emtec.com/zoc/).

Regardless of which terminal emulation program is used, it is important to configure it for 9,600 baud, 1 stop bit, 8 data bits, and no parity (often referred to as 9600-N-8-1 in programs). In HyperTerminal, the setup screen should look like Figure 58.
When the proper serial communications parameters are set in HyperTerminal, and the CD42-R unit is connected to the computer, turning on the CD42-R system should yield output similar to Figure 59, depending upon which version of the system you have:

As usual, you should press any one of the buttons of the CD42-R receiver to bypass the opening screen and begin using the system. While the CD42-R receiver is in normal operation, it continuously scans for the user to press the ENTER key on his keyboard. At this point, press the ENTER key one time, and you should see Figure 60.
This menu uses standard "highlight bar" selection, so simply pressing the "up arrow" and "down arrow" keys on your keyboard should allow you to highlight one of the four possible selections. If you do not receive the above menu after pressing ENTER, then you should first check your cabling and your communications configuration. If these things seem to be correct, then verify that the batteries in the CD42-R are functioning, and that the power is turned on. If you still have problems, please feel free to contact the manufacturer listed on the title page of this manual for further assistance.

View/Transfer File Data

The View/Transfer File Data command can be used to permanently store a set of recording image data to your personal computer. The image data is output in a platform independent manner called "comma delimited text" or "comma separated values" (CSV). CSV files are very generic and versatile and may be operated upon by a great many computer programs. Spreadsheet programs such as Microsoft's Excel are capable of directly reading in these CSV files and rendering them back into the original graphical data. This process is demonstrated below.

To select the View/Transfer File Data menu option, move the black highlight bar using the up and down arrow keys so that it is highlighted black and press ENTER. The View/Transfer File Data menu selection is displayed as shown in Figure 61.
The display changes to show the total number of recorded files in the CD42-R’s memory. In the Figure 61 example, we have a total of two recordings, both from January 1st, 1996. Follow the onscreen instructions to select the recording that you are interested in. Once you have the appropriate file highlighted with the menu bar, press the ENTER key. Doing so presents you with text that asks you to "Please open a log file on your local computer and press ENTER. The file's information will be dumped as comma delimited numerical text."

Opening a log file on your local computer allows the data that is about to be dumped from the CD42-R’s memory to be "captured" and permanently stored on your local computer's hard or floppy disk drive. All terminal programs perform this function slightly differently, but if you're using HyperTerminal, the menu is shown in Figure 62.

Once selected, the Capture Text option will ask you for the name of a disk file to store the data into. Normally this name would be 8 characters or fewer, but under Windows '95, Windows '98, Windows XP and Windows NT this name can be of any length. For ease of use, please give the file an extension of .CSV. For instance, the first pig passage recording may be called "Passage One.CSV". The CSV extension is significant to spreadsheet programs, indicating to them that the file contains "Comma Separated Values".
Once the capture file has been named and opened by the terminal program, simply press ENTER on your keyboard again. The CD42-R will "dump" the data to the screen, which will also be written into the capture file. The data dump will normally look similar to Figure 63.

![Data Dump Example](image1.png)

**Figure 63  Data Dump Example**

As you can see, the bulk of the information is indeed "comma separated values". Once the dump has completed, the capture file must be closed. This prevents everything else that you do with the CD42-R during the session from being logged to disk. To close the capture flag with HyperTerminal, choose "Stop" as shown in Figure 64.

![Closing Capture Text File](image2.png)

**Figure 64  Closing Capture Text File**

You now have successfully stored the image of a given pig passage to disk. You may now open it directly from within a spreadsheet program by specifying the file to open is a *.CSV file and then you may use that program's charting functions to manipulate the data in any way that you wish. You may also overlap recordings, join recordings together, or anything else that you can think of doing with a spreadsheet program. Figure 65 is a Microsoft Excel image created with the above captured data by simply choosing to generate a line graph.
Dump File Dates/Times

The Dump File Dates/Times menu option works similarly to the View/Transfer Data File option (Figure 61). This time, however, only the number of the recording in memory, the date, the time and the mile marker position are dumped to the capture file. Again, this data may be manipulated with standard spreadsheet programs as described in the section above. To learn how to capture and manipulated the data, please read the section on View/Transfer Data File above. A sample dump of File Dates and Times is shown in Figure 66.
**View Transmitter Signal**

The View Transmitter Signal option allows a PC computer running a terminal emulation program such as HyperTerminal to directly watch a real-time display of receiver coil input signals. This has limited use in the real world, but is occasionally useful for testing purposes. To see the real-time waveform display, simply highlight the View Transmitter Signal menu item and press ENTER. The CD42-R will prompt you with "Vertical display of antenna input. Press ENTER to start, any key quits." Once you begin watching the waveform, it is important to remember that any key will quit the operation, as no other prompting will occur. A sample of the vertical real-time waveform output is shown in Figure 67.

![Serial Interface Antenna Signal Assembly](image)

**Figure 67**  Serial Interface Antenna Signal Assembly

In this image (Figure 67) we see the transmitter pulses being displayed vertically instead of horizontally as the CD42-R’s system LCD display does. This is simply because of the limitations of the serial interface. This image does not scroll from the right to the left, but instead scrolls from the bottom toward the top.
Version/Statistic Info

The Version/Statistic Info menu selection displays current information regarding the status of the CD42-R system, as well as contact information for CDI, the original manufacturer of the system. Highlighting and selecting Version/Statistic Info displays data similar to Figure 68.

![Figure 68 Serial Interface Version/Statistic Info](image)

Included on this screen are the following pieces of information:

1. Contact information for CDI.
2. The version number and the compilation data of the firmware of the system.
3. The Equipment Owner text. This text is displayed on the opening screen when the system is first booted.
4. Card Number. The serial number of the electronics circuit board.
5. Chassis Number. The serial number of the hardware chassis that the electronics circuit board is housed in.
6. The current battery voltage as measured by the system.
7. The current amount of memory used by all recordings in memory.
Chapter 4 - Transmitters

All CDI transmitters emit a magnetic field that passes through the pipeline and any surrounding soil or water and is received by our CD42-GP. This signal is then passed along to the CD42-R receiver where it is amplified and displayed. A variety of different transmitters are manufactured to fit differing line sizes and applications from 2” and up. Older transmitter units emit a pulsing pattern that is fixed (CD42-T1, CD42-T2, etc.), while newer transmitters are programmable and emit either the standard fixed pattern by default, or by flipping a switch can emit either a distinctive pattern or a pattern that the user creates (CD42-T1, CD42-T2, etc.). For typical pigging jobs involving a single transmitter there is no real difference between the two types of transmitters, however, for jobs involving multiple pigs in a train, using differing transmitter patterns allows one to distinguish one pig from another.

In addition to variable pulse patterns, the newer programmable transmitters have an optional delay of anywhere from 10 minutes to several months before they begin pulsing. This feature is useful for when the pig is loaded into the launcher but may not actually be launched for some days.

Specifications

**CD42-T0** (Figure 69)
- Typical transmission range through pipe of 15 feet and through air of approximately 40 feet
- Recommended for use in pipelines 4” to 6” in diameter
- Guaranteed minimum 168 hour battery life (1 week)
- Pressure rated to 2,000 PSI [approximately 130 bar]
- Cylindrical dimensions of 7.1” X 1.66” [181mm X 42mm]
- Powered by 6 N-Cell alkaline batteries

**The CD42-T1A** (Figure 70)
- Typical transmission range through pipe of approximately 25 feet
- Recommended for use in pipelines 8” to 28” in diameter
- Guaranteed minimum 500 hour battery life (21 days)
- Pressure rated to 1,500 PSI [103.4 bar]
- Cylindrical dimensions of 9.9” X 1.9” [251mm X 48mm]
- Powered by 6 AA-Cell alkaline batteries

**CD42-T1** (Figure 71)
- Typical transmission range through pipe of approximately 25 feet and through air of approximately 50 feet
- Recommended for use in pipelines 8” to 28” in diameter
- Guaranteed minimum 500 hour battery life (21 days)
- Pressure rated to 2,500 PSI [170 bar]
- Cylindrical dimensions of 10.7” X 3” [272mm X 76mm]
- Powered by 6 AA-Cell alkaline batteries
**CD42-T2** (Figure 72)

- Typical transmission range through pipe of approximately 50 feet and through air of approximately 50 feet
- Recommended for use in pipelines 30” to 60” in diameter
- Guaranteed minimum 375 hour battery life (15½ days)
- Pressure rated to 2,500 PSI [170 bar]
- Cylindrical dimension of 13” X 4.4” [330mm X 112mm]
- Powered by 6 C-Cell alkaline batteries

**Replacing the Transmitter’s Batteries**

Remove the CD42-Tx transmitter from the carrying case and examine it. Notice that its only real distinguishing features are that it has one removable end (Figure 73), and a narrow groove that runs around its middle. The removable end is for the insertion of batteries, and the groove around the middle is to allow the transmitter to be attached to a metal bodied pig with the use of an optional flange kit.

Using a Phillips head Screw driver, loosen the five screws to remove the cap.

![Figure 73 Replacing The Transmitter Batteries](image)

**WARNING:**

*Use caution when removing the end cap of any transmitter. An O-Ring seal is used to withstand the pipeline pressures and if this seal becomes damaged or excessively dirty, pipeline pressure can leak into the transmitter and destroy it. Further, pipeline pressure can become trapped inside the transmitter. Always point transmitters away from yourself and others when removing the end cap. Should you require replacement O-rings, they are readily available from CDI at a nominal charge.*

Once the end cap is removed, the battery carousel (Figure 74) slides easily out into your hand. Simply remove the used batteries one at a time and replace them with fresh ones. Pay special attention to the fact that the positive end of the battery is inserted into the end of the slot with the red plastic indicators. The different transmitters sold by CDI require different types of batteries, however, all of the batteries that are used are readily available. The CD42-T1A and the CD42-T1 both use AA-Cells, the CD42-T2 use C-Cells. All of these batteries are standard alkaline type. For our smallest transmitters, the CD42-T0 N-Cell alkaline batteries are used, these
batteries are typically not difficult to find either, as they are frequently used in calculators and cameras.

To reassemble the transmitter, simply reverse the disassembly procedure. After installing new batteries into the carousel, slide it into the transmitter’s body. Be sure that you replace the battery carousel in the proper orientation. The carousel is clearly marked as to which end should be left facing out when you drop it into the transmitter, as shown in Figure 73. *Please be sure that once the batteries have been installed that you can see the text “THIS END OUT” on the side of the battery hold that is facing outward* Figure 75.

Once the battery carousel has been placed correctly into the transmitter, place the cap of the unit back into place. If you find it difficult to reinstall the cap, check the O-Ring for lubrication. If the O-Ring is dry, bare rubber, apply some Vaseline or other petroleum based jelly to it and to the inside of the transmitter body where the O-Ring meets. This should remedy the problem. Screw the cap back in place with the five screws.

The transmitter should now be transmitting its magnetic signal. Please take a moment to verify that it is operating correctly by checking its signal with the CD42-R receiver. This step is especially important prior to launch – please do not launch a transmitter into a line without verifying that it is transmitting properly.
Transmitter Patterns

If you are using multiple transmitters in a pig train, it is usually useful to be able to distinguish these pigs from one another. The newer CDI transmitters (CD42-T0, CD42-T1A, CD42-T1, CD42-T2) have the capability to transmit both the standard pulsing pattern or a pattern that is selectable by the operator. The easiest way to use this feature is to simply flip a switch located inside the transmitter’s body. If you have a programmable transmitter, remove its end cap and look down into the cavity. You should see a set of two tiny switches located in the bottom of the unit where the battery carousel normally makes contact (if you don’t see switches then the transmitter is not programmable). These switches are shown in Figure 76, Figure 76 and Figure 78 and have the ability to put the transmitter into several different modes of operation. The modes are:

1. **Standard CD42-T1 pulsing pattern (default)** (Figure 76)
   The standard mode where the transmitter emits a continuous string of pulses. In this mode the transmitter will emit a pulse every 1.5 seconds.

![Figure 76 Pulsing Pattern](image)

2. **“Skip one” mode** (Figure 77)
   Instead of transmitting a constant string of pulses the transmitter emits two pulses and then “skips one” before emitting two more pulses. This allows you to distinguish one transmitter from another in a train that is emitting a standard continuous string, but it can also be used to conserve battery power if your job is long.

![Figure 77 Skip One Mode](image)

3. **Constant-on mode** (Figure 78)
   This mode causes the transmitter to emit a continuous magnetic field without pulsing. This mode is particularly useful when the transmitter is being used for benchmarking through the pipeline and you are concerned that a pulsing transmitter could be missed.

![Figure 78 Constant-On Mode](image)

Any of CDI’s transmitters have the ability to be programmed with a pulse pattern that is completely configurable, and in addition have the ability to have a delay-on time programmed that can be as long as several months. These transmitters accomplish this by incorporating a very tiny computer that drives the electronics. This transmitter then has the ability to have software uploaded to it that modifies its behavior. Contact CDI at support@pigging.com, or on our web site at www.pigging.com, or by calling us at +1(918)258-6068 to discuss programming custom waveforms and delay-on times.
Mounting the Transmitter on your Pig

Foam Polypigs
In general the CD42-T1 transmitter will fit into the recessed cavity of a polypig. The dimensions of the CD42-T1 are compatible with the Pipeline Inspection Company PT-275. This means that a pig fitted for a PT-275 can accept the CD42-T1.

Metal Bodied Pigs
Most metal body pigs require a flange mounting kit, obtained from CDI. This kit allows the CD42-T1 to be bolted to the body of a metal pig.

Miscellaneous Pigs
The CD42-T1 transmitter is designed to fit into, or be towed behind all types of pigs. Pigs that have been previously equipped with Pipeline Inspection Company’s SPY transmitters are mount compatible with our CD42-T1 transmitter.

Transmission Strength and Battery Life
Battery strength effects reception by decreasing the strength at which the CD42-Tx transmitter emits its pulses. Therefore, as the batteries in the transmitter diminish, the range of its pulsed signals will shrink. However, CDI’s transmitters are designed to minimize this effect, and you may notice that the transmitter strength will remain quite strong up until the device’s rated life and then will drop off quite rapidly – this is by design and should not be of concern.

Routine Maintenance of Transmitters
CDI’s transmitters require minimal routine maintenance, however, proper care of the transmitter is still important to prolonging its operational life.

The following steps should be followed during each assembly of a transmitter:

1. The rubber O-Ring seal should be carefully inspected for bits of soil, hard petroleum flakes, grass, or any other foreign matter that might cause the O-Ring to be unable to effectively seal against its mating surface.

2. The facing surface to which the O-Ring mates should be carefully inspected for foreign matter that might cause the O-Ring to fail to mate effectively.

3. The facing surface to which the O-Ring mates should be carefully inspected for damage such as dents, nicks, scratches or any other mechanical deformity that might cause the O-Ring to be unable to effectively seal against its mating surface.

4. The O-Ring and the facing surface should have a light coating of a petroleum jelly such as Vaseline to reduce any friction between the two surfaces during assembly. This will prolong the life of the O-Ring itself, as well as help ensure that the O-Ring isn’t damaged during the cap-tightening process.
Long-term storage of a transmitter is best accomplished by following the following steps:

1. Remove the cap from the transmitter and remove all batteries from the battery carousel.

2. Ensure that the O-Ring and the O-Ring’s mating surface have a thin film of a petroleum jelly such as Vaseline. This will help prevent the O-Ring from being deteriorated by the environment.

3. Do not reassemble the cap onto the transmitter for long-term storage with the O-Ring in place; this could cause the O-Ring seal to take a shape flattened on the outside where it meets the mating surface of the transmitter. Such a flattened face could degrade the O-Ring’s ability to hold pipeline pressure. If you need to store the transmitter in an assembled state, we recommend removal of the O-Ring.

4. When reassembling the transmitter after a period of long-term storage, please follow the routine assembly inspection steps.
Chapter 5 - The Antenna

**General Purpose Antenna**

The CD42-GP is the General Purpose antenna of the CD42 system. It has several aspects that make it the antenna of choice in the field.

- The CD42-GP rejects, to a great extent, the earth’s magnetic field. What this means to the operator is that he can, for the first time with any pig tracking and locating system, *walk at a normal pace and search for transmitter pulses simultaneously.*
- 50+ foot reception range in open air.
- 25+ foot reception range in a pipeline.
- The CD42-GP is watertight, able to withstand being submerged to a depth of several feet. Very convenient for swamp or under-river duties.
- Integral shoulder strap included.

The CD42-T1 transmitter emits magnetic flux signals much like an electromagnet. The orientation of the CD42-GP antenna to the CD42-T1 transmitter affects the reception of the signal in a somewhat complex manner. Generally speaking, the coupling of the CD42-T1 transmitter to the CD42-GP antenna is best when they are held perfectly parallel to each other. This causes the magnetic flux lines to pass completely through the CD42-GP antenna longitudinally, generating the highest voltage and the largest signal on the CD42-R display. This is known as the Pattern of Inductive Coupling, or PIC.

This aspect of the PIC phenomena is most useful when the operator is walking the pipeline searching for a stuck pig equipped with a transmitter. In these instances the operator usually walks above or beside the pipeline, where there may or may not be ground cover, and holding the antenna parallel to the pipeline is the most convenient. The closer the operator is to the transmitter, the higher the signal strength displayed on the CD42-R.

When the CD42-GP antenna is held perfectly perpendicular to the CD42-T1 transmitter, the magnetic flux lines pass through the antenna in a perpendicular fashion, generating the least amount of voltage. Consequently, these magnetic transmissions show up as little or no signal strength on the display of the CD42-R. As the receiving antenna is swept back and forth through the magnetic flux lines, while continually being held perpendicular to the transmitter, the signal strength will increase slightly as the distance from the transmitter becomes greater and then begin to fade again. This is because some slightly greater amount of magnetic flux lines are traveling down the length of the antenna. This aspect of the PIC phenomena is most useful when *nulling* and the precise location of the transmitter is desired.
Chapter 6 - Tracking a Moving Pig

Using the CD42 to "Leapfrog"

In order to have a general idea of the pig’s vicinity, it is a good idea to leapfrog the pig as it traverses the pipeline. If the pig becomes stuck, the operator can backtrack to the last known good passage location by walking the pipeline and looking for transmitter pulses using the CD42-R receiver.

The operator should have a rough idea of the flow rate of the pipeline, and allow enough time between points to set up the equipment and begin looking for the pig. When an operator sets up the CD42-R at a location to await a pig passage, he should orient the receiving antenna parallel to the pipeline. As the pig approaches the location and then moves away, it produces a distinctive wave shape on the display. Figure 79 is an example of a typical pig passage.

After the operator has identified a pig passage, he should then move immediately to the next leapfrog point. If the pig passes the leapfrog point before the operator arrives and has the equipment set up, then the operator may quickly lose track of the pig. This may cause much more time to be spent locating the pig if it does become stuck.

In order to leapfrog properly, the operator needs to locate the leapfrogging points on the pipeline as close together as possible. This will minimize the distance the operator will have to walk to locate a stuck pig.
Leaving the CD42 Unattended

If the CD42-R is set up to record in Automatic mode, it can be used to detect pigs in an unattended fashion. This might be useful if an operator simply wanted to know if a pig, or any number of pigs, passed a certain location in the middle of the night.

To accomplish this, place the CD42-R receiver in the location to be monitored. Be sure the CD42-R is in Automatic record mode (Figure 80). The CD42-R will turn itself on and automatically begin recording when it detects a valid pig passage. When the operator returns to check the CD42-R, the display will verify how many pig passages have been recorded. The time of the recording can also be displayed in the File Menu. Refer to the section titled “File Menu” on page 23 for information on viewing and manipulating File Recordings.

![Figure 80 Automatic Record mode](image)
Chapter 7 - Locating a Stationary or Stuck Pig

Finding the Pig's General Vicinity

When trying to find the general location of a pig, the operator should first be sure that the Gain of the CD42-R is properly set. If the surrounding environment is noisy, turn the gain down so that the ambient noise shown on the screen is no higher than the second row of “dots” across the lower part of the screen. If the Gain is turned down too low, the transmitter will not be located by the CD42-R receiver. If the Gain is turned up too high, the transmitter signal will be “hidden” in the noise. A Gain setting of 5-7 should prevent the operator from walking past the pig without locating it.

If the operator leapfrogged the pig properly (Chapter 6 - Tracking a Moving Pig) then he should have an area bounded by the leapfrogging points where the pig is located. Simply walk the pipeline, as close as possible, and watch the screen of the CD42-R begin to display the pulses of the CD42-T1 transmitter. While this is being done, it is very important that the CD42-GP antenna be held parallel (Figure 81) to the pipeline.

While the antenna is being held parallel, the waveform signals will get stronger the closer the operator is to the pig (Figure 82). This allows the operator to simply walk the area until a signal is present, no matter how faint, and then walk in the correct direction to make the signal strength rise. If the operator walks past the pig, the signal strength will begin to fall. Once the operator thinks the pig has been located, make a positive ID by laying the antenna down on the ground and verifying the pulse of the transmitter.

Figure 81 A Parallel GP Antenna Orientation
Pinpointing a Pig’s Precise Location

Once the general vicinity of the pig has been located, it is now time to find the exact location of the pig. This can be done by switching the orientation of the CD42-GP antenna to an angle perpendicular to the pipeline (Figure 83). This means holding the antenna in such a way so that the end of the antenna is pointing at the transmitter.
With the antenna perpendicular to the pig, an exact location can now be determined. The waveform signals will now be the reverse of a parallel orientation. As the operator moves the antenna closer to the pig the signal strength drops until reaching the null (Figure 84), or point of little or no signal, when the antenna is directly over the pig. Move the antenna back an inch or two, and the signal strength will rise. Move farther away and the signal will disappear altogether. With this technique, the operator can pinpoint the exact location of the pig.

![Nulling the transmitter](image)

**Figure 84** Nulling the transmitter

As a side note, be aware that the operator must have already located the general vicinity of the pig using parallel orientation of the antenna. Transmission range is severely limited with a perpendicular orientation and is not suitable for random pig location.
Appendix A - Specification Summary

**The Receiver**
- Weighs 7.0 lb., with batteries installed
- Dimensions 5.25” x 9.375” x 8”
- Chassis
  - Machined from 18 gauge stainless steel
  - Solid nylon handles
  - Watertight, with the back plate installed
  - Six buttons, sealed Military Spec capable of operating under three feet of water
  - Hard plastic enclosure is polycarbonate, with a silicone rubber gasket
- Built-in speaker
- Liquid Crystal Display, with backlight
- Industry standard PC type 25 pin parallel printer port
- Industry standard PC type 9 pin serial port (RS-232C)
- Rated battery life of 40 hours minimum with all options on, including backlight

**The Transmitters**
- The CD42-T0
  - Typical transmission range through pipe of approximately 15 feet
  - Recommended for use in pipelines 4” to 6” in diameter
  - Guaranteed minimum 168 hour battery life (1 week)
  - Pressure rated to 2,000 PSI [130 bar]
  - Cylindrical dimensions of 7.00” X 1.66” [178mm X 42mm]
  - Powered by 6 N-Cell alkaline batteries
- The CD42-T1A
  - Typical transmission range through pipe of approximately 25 feet
  - Recommended for use in pipelines 8” to 28” in diameter
  - Guaranteed minimum 500 hour battery life (21 days)
  - Pressure rated to 1,500 PSI [103.4 bar]
  - Cylindrical dimensions of 9.9” X 1.9” [251mm X 48mm]
  - Powered by 6 AA-Cell alkaline batteries
- The CD42-T1
  - Typical transmission range through pipe of approximately 25 feet
  - Recommended for use in pipelines 8” to 28” in diameter
  - Guaranteed minimum 500 hour battery life (21 days)
  - Pressure rated to 2,500 PSI [170 bar]
  - Cylindrical dimensions of 10.7” X 3” [272mm X 76mm]
  - Powered by 6 AA-Cell alkaline batteries
The CD42-T2

- Typical transmission range through pipe of approximately 50 feet
- Recommended for use in pipelines 30” to 60” in diameter
- Guaranteed minimum 375 hour battery life (15½ days)
- Pressure rated to 2,500 PSI [170 bar]
- Cylindrical dimension of 13” X 4.4” [330mm X 112mm]
- Powered by 6 C-Cell alkaline batteries

**The Antenna**

- Weighs 6.0 lb.
- Shoulder strap included
- Receives open air signals to a distance of 50 feet.
- Waterproof
- 6 ft. cable included, 20 ft. cable optional
## Glossary of Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electromagnet</td>
<td>A core of magnetic material surrounded by a coil of wire through which an</td>
</tr>
<tr>
<td></td>
<td>electric current is passed to magnetize the core</td>
</tr>
<tr>
<td>Magnetic Field</td>
<td>The portion of space near a magnetic body or a current carrying body in which</td>
</tr>
<tr>
<td></td>
<td>the forces due to the body or current can be detected</td>
</tr>
<tr>
<td>Magnetic Flux</td>
<td>Lines of force used to represent magnetic induction</td>
</tr>
<tr>
<td>Null</td>
<td>Indicated by a zero reading on a scale; indicates center of transmitter</td>
</tr>
<tr>
<td>Parallel</td>
<td>Extending in the same direction</td>
</tr>
<tr>
<td>Perpendicular</td>
<td>Extended at right angles</td>
</tr>
</tbody>
</table>
Index

A
Antenna .................................. 6, 9, 52, 59
Automatic Record Mode ....................20
  Features ..................................21
B
Backlight ..................................30
Battery
  Changing ..................................11, 47
Battery Life ..................................50
Battery Voltage ..................................34
Baud Rates .................................. See PC Computer
Beep ...........................................36
C
CD42-R
  Purpose ..................................5
  Unattended ..................................54
CDI
  Who ...........................................5
Clock .........................................32
Contrast ......................................32
Copyright Notice ..............................2
F
File Dates and Times
  Dumping to PC ..................................43
File Menu .................................. See Recording File
Fix ..............................................37
G
Gain Button ..................................16
H
Help Button ..................................16
I
Introduction ..................................5
L
Leapfrogging ..................................53
Location ID ................................. 17, 36
  Entering ..................................19
M
Main Screen ..................................15
Manual Record Mode ..........................22
  Features ..................................22
Meter Display ..................................31
Mounting Transmitter .........................50
N
Nulling ...........................................52
P
Pattern of Inductive Coupling ..............52
PC Computer
  Connecting to ..................................38
PIC ...........................................52
Pig Locating ..................................55
Pig Speed .................................... 26
Printing ......................................... See Recording File
Q
QuickStart
Antenna ...........................................8
Assembly ...................................... 6
Battery Replacement .........................11, 47
Pig Passages ..................................12
Receiver .......................................7
Stuck Pigs .................................... 13
Tracking .......................................12
Transmitter ................................... 9
R
Receiver .......................................15
Record Mode ..................................35
Recording File ..................................23, 54
  Erasing ...........................................23
  Printing .......................................27, 28, 29
  Selecting .......................................23, 24
  Tagging ...........................................25
  Viewing ...........................................24
  Recording Pig Passages .....................17
  Maximum Number Of .........................17
RS-232C ...........................................38
S
Screen Blanking ..................................15
Serial Port ................................. See PC Computer
Setup ...........................................29
Backlight ......................................30
Battery Voltage ..................................34
Beep .......................................... 36
Clock .......................................... 32
Contrast ...........................................32
Fix ..............................................37
Location ID ..................................36
Meter Display ..................................31
Record Mode ..................................35
### CD42 Pipeline Pig Location & Tracking System

#### T
- Tagging: See Recording File .......................... 9
- Transferring Data ........................................ 40
- Transmitter .................................................. 46
  - CD42-T0 ................................................. 46
  - CD42-T1 ................................................. 46
  - CD42-T2 ................................................. 47
- Changing Batteries ........................................ 47
- Constant-on Mode ........................................ 49
- Custom Pulse Patterns ................................. 49
- Default Mode ............................................ 49

#### U
- Mounting ................................................. 50
- Routine Maintenance .................................. 50
- Skip-one Mode .......................................... 49
- Transmitter Signals
  - Viewing Real-Time .................................... 44

#### V
- Unattended ............................................... 53
- Version/Statistic Info .................................. 45